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About NEScom

NEScom Windows application provides a means for querying and
controlling NESLAB products over an RS232 connection. The
application bases all actions on controller icons. Once a control-
ler icon is created, product parameters can be read and con-
trolled.

Features include the capability to view and print a temperature
and setpoint chart, configure and log alarms, run and save
programs, and view indicators in the form of gauges and meters,
all from menu bar selections.

NEScom Help will provide answers to the questions that will arise.
Use keywords to obtain information in Help searches. Click on
Help buttons for shortcuts to help topics. A glossary of terms is also
located in the back of this manual.

Installing NEScom

The setup program installs NEScom and a run-time engine onto your
system. Your system should have 3 -4MB disk space. Since the
runtime engine requires a math coprocessor to run, we recommend
installing NEScom on at least a 486 DX-33 PC with 8MB of RAM.
Follow these instructions for the appropriate version of Windows:

Windows 3.x
Select Run from the File menu in the Program Manager
Type a:setup.exe (if installing from the A: drive).

Windows 95
Select Run from the Start menu.
Type a:setup.exe (if installing from the A: drive).

Setup allows you to name the installation directory to copy files.
Change the destination directories by selecting Change (though
we recommend you use the defaults). Once the directory names
are approved select Finish to complete the installation.
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Getting Started

RS232 Connection & Cables

NESLAB has cables and adapters to interface your computer to a
NESLAB product. If you have a cable question, please check your
configuration against the cabling suggested below. If your NESLAB
product is not listed in this section call 800-NESLAB for assistance.

Computer Interface:
NESLAB suggests connecting the 25-pin male connector on your
computer to a NESLAB product with the appropriate NESLAB cable
listed below. Use NESLAB Adapter P/N 001935 to convert a 9-pin
male port to a 25-pin male port.

NESLAB Product:
RTE, EX 110/210/220/410/510 (modbath digital/programmable):

NESLAB Cable P/N 001911 from computer to MRS232C.
MRS232C to bath.

RTE,  EX 111/211/221/411/511 (bath93 digital and HX Series II
controllers):

NESLAB Cable P/N 001911 from computer to MRS232C
MRS232C to bath.

RTE,  EX 111/211/221/411/511 (bath93 microprocessor):

NESLAB Cable P/N 001912 from computer to bath.

LT, ULT, EX250/251 (Digital Exatrol):
NESLAB Cable P/N 001911 from computer to RS232C
RS232C to bath.

Troubleshooting:
If there is a problem contacting the product check the cable
connections and ensure the NESLAB product is powered and
RS232 communications is enabled. Check the parameters in
Configure COM port in the Options menu. Ensure the protocol
being used by NEScom is supported on the NESLAB product.
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Initialization

When NEScom is executed for the first time you are prompted to
enter your name as the licensee. The program will then indicate
the default communication parameters. (The only other time this is
required is if the initialization file gets corrupted.)
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File Menu

Select File from the menu bar to display the window shown below.
This menu allows you to create, open, delete or save workspaces
containing various controller configurations.

New

The options are Controller or Workspace.

Controller
Select to create a new Controller Icon. Icons are a graphical
representation of a product. Up to eight (8) icons can be created
for each workspace. All menu selections are based off of the
active icon. An icon is active if it is highlighted. Select an icon with
the mouse to make it active.

The background color of the active icon signifies its communica-
tion status.

Yellow means that NEScom is polling the device in an attempt to
make contact.
Blue means that NEScom successfully contacted the device but is
not currently communicating with the product.
Green indicates that NEScom is currently communicating with the
product.
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Red indicates that an error in communication occurred. Commu-
nication is resumed by manually enabling communications. See
Properties or Enable Communications.

NOTE: Losing contact with the product does not result in a timeout
error when NEScom is only requesting parameter values from the
product. In this case, NEScom enters the polling mode (Yellow)
and attempts to reconnect.

Select from the following icon types:

NC Protocol1 - General support for NESLAB products that support
the NC protocol.
MICROprocessor Bath1 - General support for NESLAB Microproces-
sor line of baths (RTE/EX).
MRS232C/RS-232C1 - General support for NESLAB Digital line of
baths and chillers that utilize the MRS232C or RS-232C.
LT90 (NC) - Support for LT-90 utilizing the NC protocol.

Workspace
Define and configure a new workspace. A Workspace is made up
of one or more controller icons. If one is already active, NEScom
will prompt you to save the current workspace before a new one
is defined or loaded. All icons are cleared when a new workspace
is created. Once new controller icons are added, the workspace
can be saved.

1. See glossary.
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Open

Select this menu item to open a previously saved workspace.

File Name:
Type the file name in the space provided or select from the
choices within the file list.

List Files of Type:
The default file type listed is *.nes.  To list all files in the directory
click on the text box and select All files (*.*).

Directories:
Choose from the default directory or browse through the directory
structure.

Drives:
Choose from the default drive or select from other drive choices.

Properties

Select Properties to view the window below. Properties include:
description, location/serial number, communications address and
status, read only status and password.

Description:
If desired, enter a new description of the unit selected to commu-
nicate with NEScom. This description will appear on the icon and
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any window panel associated with this icon. The description is
referenced when logging alarms.

Location:
Enter the physical location of the unit (building, lab number ...)
selected to communicate with NEScom. The location is referenced
when logging alarms.

Communications: Disabled�Enabled
This control is available only when there is a communication error.
Under error-free operating conditions this control is dimmed and
gives the status of communications. If an error occurs which
causes communications to stop, communication is re-enabled by
setting the switch to Enable.

NOTE: Communication is normally disabled when NEScom is not
requesting parameters from the product. Once you configure
NEScom to request data from the product, communication is
automatically enabled.

Comm. Protocol:
This displays the current communications protocol. This display
cannot be changed.

Comm. Address:
This number is used by the NC protocol as a way to identify which
unit NEScom is communicating with. This address is significant in
protocols that support communications with multiple units (RS-485 or
RS-422). NEScom and NESLAB products supporting the NC protocol
and RS-485/RS-422 can be configured with a unique address
(1-32767). Any data sent from NEScom to the NESLAB product, and
any data received by NEScom carries this address. Default ad-
dresses are assigned automatically when icons are created.

NOTE: An address is not required for RS-232 communications.
NEScom 1.0 does not support multi-unit communications.
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Read Only:  No�Yes
When in read only mode, NEScom can only query a product for
information and not perform any intrusive setting of product
parameters (like temperature setpoint). Read Only mode is dis-
abled by entering the correct password and selecting No on the
Read Only switch.

With Read Only mode selected:

Programs cannot be started.
Setpoint cannot be changed from Product Panels.
Product Panel buttons are disabled.

Password:
A password must be entered before the Read Only mode can be
disabled. All software is shipped with the password �NESLAB� as a
default. Select Change.... to change your password.

Delete

Select this menu item to delete the active product icon within the
workspace. When an icon is deleted, the icon created first among
those remaining becomes the active icon.

NOTE: NEScom prompts to confirm the deletion. The shortcut for
delete is [Shift]+[Del].

Save

Select this menu item to save the current workspace. If the
workspace has not been previously saved then a dialog box will
appear prompting for file information.

File Name:
Type the file name in the space provided or select from the
choices within the file list.

List Files of Type:
The default file type listed is *.nes. To list all files in the directory
click on the text box and select All files (*.*).
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Directories:
Choose from the default directory or browse through the directory
structure.

Drives:
Choose from the default drive or select from other drive choices.

Save As

Select this menu item to save the current workspace under a new
file name.

File Name:
Type the file name in the space provided or select from the
choices within the file list.

List Files of Type:
The default file type listed is *.nes.  To list all files in the directory
click on the text box and select All files (*.*).

Directories:
Choose from the default directory or browse through the directory
structure.

Drives:
Choose from the default drive or select from other drive choices.

Print

Select Print from the menu choices to print a hard copy of a
graph of the program in memory, a snapshot of the strip chart, the
product control panel or the contents of the alarm log.

Program:
After a Program is created and loaded into memory a hard copy
can be made. You can print the program in the form of a graph
or plain text. A Program must be viewed if printing in graph form.

Chart:
A chart must be viewed before it can be printed. Only the portion
viewed will be printed.
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Control Panel:
A control panel must be viewed before it can be printed.

Alarm Log:
An Alarm Log must be opened before it can be printed. The
output of the alarm log goes to the default printer.

Exit

Select Exit from the menu choices to exit the program. If the
workspace has changed since the last save, a save-message
prompt will appear before exiting.
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View Menu

Select View from the menu bar to view program graphs, strip
charts, product control panels and alarm logs.

Program

Select Program to view a graphic representation of the current
program. The program graph panel can be maximized or mini-
mized but not re-sized. Restore a minimized program graph by
selecting the appropriate window panel from the Window menu
bar selection. Real-time plotting of temperature occurs once a
program is started.

NOTE: A program must first be stored in memory, then viewed in
order to be printed.
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Time Scale:
Select this to switch between time scales. Choose from seconds,
minutes or hours. The program graph panel defaults to minutes.

Close:
Select this to close the program graph panel.

Print:
Select this to print the program graph panel. The program can
also be printed from the File menu.

Help:
Select this to display this help topic.

NOTE: A check mark to the left of the menu item signifies that the
program graph panel exists for the active controller icon. Select-
ing this menu item when checked closes the program graph
panel.

Chart

Select Chart to view a runtime plot of temperature and setpoint or,
if the NC protocol is supported, any two product parameters. The
strip chart can be maximized and minimized but not re-sized.
Restore a minimized strip chart by selecting the appropriate
window panel from the Window menu bar selection.

NOTE: A chart must be viewed in order to be printed.

When selecting this menu item, you are prompted with a pop-up
panel for selecting which chart parameters to view and in what
format to display the data, see figures on pages 14 and 16.

NOTE: A check mark to the left of the menu item signifies that the
chart panel exists for the active controller icon. Selecting this
menu item when checked closes the chart panel.
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Time/division:
This selects the time interval for the x-axis divisions. There are
always 24 divisions displayed along the x-axis. This time is in
seconds unless the intervals are greater than five seconds. In this
case the time scale for the x-axis is in minutes.

Log File� (Close File):
Select this to output data acquisition to a file. The file contains a
column for time and a column for each parameter being
sampled. Time is in seconds and starts with zero. The log interval is
configurable, select 1, 10 or 60 seconds. Parameter headings are
automatically logged to the file when it is first opened and data is
written to the file as long as it is open. Close the file by clicking on
�Close File� or by closing the chart panel.

Close:
Select this to close the chart panel. The operator is warned that
the log file will also close (if open).

Setup:
Select this to bring up a panel for choosing which chart param-
eters to view and in what format to display the data.

Print:
Select this to print the chart panel. The chart can also be printed
from the File menu.

Help:
Select this to display this help topic.
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Chart Parameters

Chart parameter selection and format precede the creation of a
chart. Format and parameter selection can be modified once a
chart exists by selecting Setup. Depending on which controller
icon type is active, the look of the Chart Parameters pop-up panel
may vary. Only those controller icons supporting the NC protocol
provide the flexibility of selecting from a variety of parameters to
chart. Of all the parameters supported in the NC protocol, only
those parameters supported in the actual product can be plotted
on the chart. Selecting a parameter that is not supported has no
affect on the strip chart.

NC Protocol
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Parameter 1/Parameter 2: Select from the list of parameters.
Any parameter not supported is indicated in the reference text
box below the label field. To create a chart, Parameter 1 must
exist.  Parameter 2 is optional.

Label: By default, the parameter name appears in the Label
field.  This field can be edited and is limited to 30 characters. The
label appears in the chart legend and as a title for the y-axis. If
two parameters are charted, the label for the parameter with the
widest range of y-values is used as the y-axis title.

High Value: Enter the upper limit for the parameter.

Low Value: Enter the lower limit for the parameter.

Color: Choose from 16 color choices.

Type: Choose a line style (thin line, thick line, or plotted points).
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Microprocessor and MRS232C Protocols

Parameters: Chart temperature and setpoint.

Label: This field can be edited and is limited to 30 characters.
The label appears in the chart legend and as a title for the y-axis.
The label for the parameter with the widest range of y-values is
used as the y-axis title.

High Value: Enter the upper limit for the parameter.

Low Value: Enter the lower limit for the parameter.

Color: Choose from 16 color choices.

Type: Choose a line style (thin line, thick line, or plotted points).
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Product Panel

Select Product Panel from the View menu to view the control panel
of the active product icon. All features of the product panel are
disabled in the read-only mode. If attempting to perform a
function that requires disabling read-only mode, you will be
prompted with a message or a beep indicating that the unit is in
read-only mode.

Generic Product Panel:
All Generic controller icons share a generic product panel which
displays temperature and temperature setpoint. The temperature
setpoint can be updated when read-only is disabled. This is done
by entering a number in the �New Setpoint� field and clicking on
the �Update� button.

Alarm Log

Select Alarm Log from the View menu to view the contents of the
alarm log in a pop-up window panel. An alarm log file must be
opened in order to be viewed. Scroll through the alarm log with
the vertical and horizontal scroll bars.
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Program Menu

NEScom provides a means for programming temperature
setpoints over time. Setpoint ramp and soak functions are entered
as program steps. Any sequence of steps can be repeated up to
999 times with the program-loop feature.

Program Parameters

Programs are built/edited, viewed and controlled using the
Program Panel window. The panel is divided into the Program Edit
Window (top), the Program View Window (bottom) and the Pro-
gram Panel Buttons (side).
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Program Edit Window
Program steps are defined by their step number. Use this window
to enter program steps. Adding, inserting, deleting and replacing
steps is accomplished by first choosing a step number.

Step: Up to 12 steps can be entered starting with step 1. This field
cannot exceed the highest programmed step number.

Begin Temp: Enter the beginning temperature of the program step.

End Temp: Enter the ending temperature of the program step.

Time (min): Enter the duration of the program step in minutes.
Setpoint soak is achieved by setting the start and end tempera-
tures to the same value. Soak time is the period of time entered
here. Once a step is completed, the program resumes to the next
step in the program unless # Loops, see below, is set greater than
zero. The maximum duration for a single step is 9999.9 minutes.

# Loops: A sequence of steps can be repeated to create a
program loop. A number other than zero entered in this field equals
the number of times a sequence of steps is repeated. When a
program encounters a nonzero number for # Loops, it will go to the
step number entered in Loop To Step and repeat this action as
many times as indicated. Once the number of loop repeats is
reached, the program resumes to the next step in the normal
sequence of the program. A loop can repeat up to 999 times.

Final Soak: The temperature that will be maintained once the
program is completed or manually stopped.

NOTE: If a communication time-out occurs, the setpoint will remain
at the last setpoint.
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Add: After all parameters are entered into a program step, click
Add to add this step into the program.

Insert:  Inserts a program step into the program. The step number
of the inserted step, as indicated by the Step value, remains the
same and all step numbers greater than or equal to the inserted
step number are incremented by one. When a step is inserted
within a loop, the Loop To Step value for that loop is not changed.
When a step is inserted prior to a loop, the Loop To Step value for
that loop is incremented by one.

Delete: Deletes a program step from the program, as indicated
by the Step value. All step numbers greater than or equal to the
inserted step number are decremented by one. When a step is
deleted within a loop, the Loop To Step value for that loop is not
changed. When a step is deleted prior to a loop, the Loop To Step
value for that loop is decremented by one.

Replace: Replaces the program step previously entered with the
current program step.

Program View Window
This view-only portion of the window details each programmed
step. Scroll the window using the vertical scroll bar.

NOTE: Highlighting program steps in this portion of the window has
no affect on the Program Edit Window.
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Program Panel Buttons

OK: Closes the Program Panel.

Clear: Clears the entire program currently loaded.

Open: Loads a program that has previously been
saved to a file.

Save: Saves current program to the specified path
and file name.

View: Displays a graphic representation of the
current program.

Start: Starts the program. When communication is
established the program begins executing and the
controller icon turns green. The Start button changes to Stop on
the program panel when the program is running.

Stop: Stops the program. Under conditions of normal program
termination (stopped by the operator or completed as intended)
the setpoint will be set to Final Soak. The Stop button on the
Program panel changes to Start.

Help: Displays this help topic.

Start Program (Ctrl+A):

This menu selection is available only when a program has been
stored in memory. This selection starts the program at the first
program step. When the program is running, the controller icon is
highlighted green indicating that communication is established.

If the program is successfully executing, this menu selection
becomes unavailable to the operator and the Stop Program and
Pause Program selections become available. The program control
button on the program panel changes from Start to Stop. If
communication fails the icon is highlighted in red.
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Stop Program (Ctrl+O):

This menu selection becomes available once a program is stored
in memory and started. Selecting this menu item stops the pro-
gram.  When stopped manually, the program sets the setpoint to
the Final Soak value. The Stop button on the Program panel
changes to Start when a program is stopped.

Pause Program (Ctrl+U):

This menu selection becomes available once a program is stored
in memory and started. Selecting this menu item pauses the
program.  When paused, this menu item is checked and the
program does not set the setpoint to any new values. To resume
execution of the program, select pause again. A check mark at
this menu item signifies that the program is paused. The program
can be stopped when paused.

Sample Program

The following program ramps up from 20°C to 30°C in 30 minutes.
It then soaks at 30°C for 10 minutes before it ramps back down to
20°C in 30 minutes. It is repeated two times for a total of three
ramp-up/soak/ramp-down loops.

1) Enter "1" in the Step field.
2) Enter "20.0" in Begin Temp. and "30.0" in the End Temp. fields.
3) Enter "30" in the Time field and "0" in the #Loops field.
4) Select the Add button. This adds a line to the Program View

Window.
5) Enter "2" in the Step field.
6) Enter "30" in the Begin Temp. and "30.0" in the End Temp. fields.
7) Enter "10" in the Time field and "0" in the #Loops field.
8) Select the Add button. This adds a second line to the Program

View Window.
9) Enter "3" in the Step field.
10) Enter "30.0" in the Begin Temp. and "20.0" in the End Temp. fields.
11) Enter "30.0" in the Time field.
12) Enter "2" in the #Loops field and "1" in Loop To Step field.
13) Select the Add button. This adds a third line to the Program

View Window.

Select the View button to view and start the program.
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Alarms Menu

NEScom can be configured to generate warning messages when
alarm conditions occur. Alarm setup can vary depending on
which communication protocol is in use. In all cases an alarm
point is stored within the Windows application. This alarm point
may not necessarily be the alarm point of the actual product. All
alarms can be enabled or disabled with a single menu selection.

When an alarm occurs, you are prompted with a pop-up mes-
sage. This message displays the alarm description, the value read
from the product and the alarm limit. Messages also display the
icon description and location entered under icon properties. You
must acknowledge this message and then have the option to
disable the alarm.

NOTE: In all cases an alarm point is stored within the Windows
application. This alarm point may not necessarily be the alarm
point of the actual product.
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Alarm Parameters

NC Protocol
Select any alarm from the menu. The descriptions Alarm 1, Alarm
2, ... are default names which can be modified when configuring
an alarm. Alarms are configured by first selecting a specific
parameter from a list of ones supported, then entering a high limit
and low limit for that parameter. Parameter units and precision
match those of the actual product. High limit and low limit alarms
can be later enabled or disabled by recalling the alarm from this
menu. A check mark on an alarm description signifies that either
limit or both limits are enabled.

Parameters:  Select the alarm parameter. If the parameter is not
supported by the product then the reference field will read Not
Supported.

Title:  Enter a descriptive title for each alarm. This will appear as
the new description for this menu item.

High Alarm: Enter the high limit. The alarm will activate when the
parameter in question exceeds this limit.

Low Alarm: Enter the low limit. The alarm will activate when the
parameter in question is lower than this limit.
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Enable: Individually enables or disables each alarm.

Cancel: Cancels all changes made since the last save.

OK: Confirms the alarm configuration.

Microprocessor Protocol
Select from High Temperature, Low Temperature, High Remote
Temperature or Low Remote Temperature alarm. Parameter units
and precision match those of the actual product. A check mark
on an alarm description signifies that it is enabled. Selecting an
alarm menu item with a check mark disables the alarm. If the
menu item is not checked, then the operator will be asked to
enter the alarm limit. For convenience, the alarm limit is added to
the description of the menu item. Not entering a value for the
alarm limit when prompted skips the alarm setting.

MRS232C Protocol
Select from High Temperature or Low Temperature alarm. Param-
eter units and precision match those of the actual product. A
check mark on an alarm description signifies that it is enabled.
Selecting an alarm menu item with a check mark disables the
alarm. If the menu item is not checked, then the operator will be
asked to enter the alarm limit. For convenience, the alarm limit is
added to the description of the menu item. Not entering a value
for the alarm limit when prompted skips the alarm setting.

Enable All

Enables all defined alarms. See Alarm Parameters for individually
enabling alarms.

Disable All

Disables all defined alarms. See Alarm Parameters for individually
disabling alarms.
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Log Alarms

NEScom provides the means to log all alarm messages to file.
Select this menu item to create a log file. A file selection dialog
box allows the operator to easily open a file for automatic log-
ging. A check mark on this menu item signifies that an alarm log
has been opened.  Selecting this menu item with a check mark
closes the alarm log.

Alarm log entries are stamped with the date and time of the alarm
occurrence and the contents of the alarm message. The alarm
log also indicates when an alarm was acknowledge.

NOTE: View the contents of the alarm log by selecting Alarm Log
from the View menu.

NOTE: Print the contents of the alarm log by selecting Print from
the File menu.
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Indicators Menu

Indicators are graphical representations of data. Graphical
formats such as gauges, thermometers and meters are linked to
product parameters for greater visibility. An indicator is created by
selecting the specific indicator from the menu. A check mark on
the indicator menu item signifies that the indicator exists. Selecting
a checked menu item deletes the indicator.

All indicators reside in an indicator widow. The sizable window is
displayed when the first indicator for a controller icon is created.
There is a unique indicator window for each controller icon.
Indicators are dimmed for all controller icons other than the
selected active icon.

Indicators can be moved within the indicator window with the
cursor keys and sized with +/- (overall adjust), W/w (width adjust),
or H/h (height adjust).

Left-Double-Click an indicator to configure the indicator range
and title.

Indicators are outlined in red when they are out of range.
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NC Protocol
Products supporting the NC protocol have greater flexibility when
it comes to using indicators. These products support different
subsets of the entire range of parameters supported in the NC
protocol. Because of this, the operator has the ability to link any
indicator to any parameter supported by the product.

Microprocessor Protocol
NESLAB�s Microprocessor line of products provide temperature,
setpoint, high limit and low limit values. Here, the thermometer
indicators are linked to temperature and setpoint and the gauge
indicators are linked to the temperature limit values.

MRS232C Protocol
Products supporting the MRS232C protocol only provide tempera-
ture and setpoint values so two thermometer indicators are
available.

Gauge

A Gauge can be moved within the indicator
window with the cursor keys and sized with +/
- (overall adjust), W/w (width adjust), or H/h
(height adjust). Left-Double-Click on a Gauge
to configure its range and title.

NC Protocol
When selecting either 1 or 2 from the Gauge
menu item, the operator will be prompted to
link a NC protocol parameter to the indicator.

Parameters: Choose a parameter from the list choices. Param-
eters that are referenced as Not Supported will not be linked to an
indicator.

Label: Type a label for the indicator.

High Value: Enter a high value for the indicator.
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Low Value: Enter a low end for the indicator.

Values outside the entered range make the indicator go out of
range.  This is illustrated by a red outline on the indicator.

Microprocessor Protocol
High Temperature

Low Temperature

MRS232C Protocol
Not Supported

Thermometer

A Thermometer can be moved within the
indicator window with the cursor keys and
sized with +/- (overall adjust), W/w (width
adjust), or H/h (height adjust). Left-Double-
Click on a Thermometer to configure its
range and title.

NC Protocol
When selecting either 1 or 2 from the
Thermometer menu item, the operator will
be prompted to link a NC protocol
parameter to the indicator.

Parameters: Choose a parameter from the list choices. Param-
eters that are referenced as Not Supported will not be linked to an
indicator.

Label: Type a label for the indicator.

High Value: Enter a high value for the indicator.

Low Value: Enter a low end for the indicator.

Values outside the entered range make the indicator go out of
range.  This is illustrated by a red outline on the indicator.
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Microprocessor Protocol
Temperature

Setpoint

MRS232C Protocol
Temperature

Setpoint

Meter

A Meter can be moved within the indica-
tor window with the cursor keys and sized
with +/- (overall adjust), W/w (width
adjust), or H/h (height adjust). Left-
Double-Click on a Meter to configure its
range and title.

NC Protocol
When selecting either 1, 2, 3 or 4 from
the Meter menu item, the operator will be prompted to link a NC
protocol parameter to the indicator.

Parameters: Choose a parameter from the list choices. Param-
eters that are referenced as Not Supported will not be linked to an
indicator.

Label: Type a label for the indicator.

High Value: Enter a high value for the indicator.

Low Value: Enter a low end for the indicator.

Values outside the entered range make the indicator go out of
range.  This is illustrated by a red outline on the indicator.

Microprocessor Protocol
Not Supported

MRS232C Protocol
Not Supported
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Tank

A Tank can be moved within the indicator window with the cursor
keys and sized with +/- (overall adjust), W/w (width adjust), or H/h
(height adjust).  Left-Double-Click on a Tank to configure its range
and title.

NC Protocol
When selecting the Tank menu item, the operator will be
prompted to link a NC protocol parameter to the indicator.

Parameters: Choose a parameter from the list choices. Param-
eters that are referenced as Not Supported will not be linked to an
indicator.

Label: Type a label for the indicator.

High Value: Enter a high value for the indicator.

Low Value: Enter a low end for the indicator.

Values outside the entered range make the indicator go out of
range.  This is illustrated by a red outline on the indicator.

Microprocessor Protocol
Not Supported

MRS232C Protocol
Not Supported
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Status

Select Status from the Indicator menu bar to view a product�s
predefined status conditions. Status flags indicate faults, warnings
and other system conditions, and typically vary from product to
product.  Reference the product owners manual for the definition
of status bits.

NC Protocol
Up to 16 status fields can be predefined for a product. These fields
are labeled for specific products that report their status. When
viewing status for a Generic NC icon, the operator will see that the
labels for the status fields are generic as well. These labels can be
modified by selecting the field and typing the status label name.

Microprocessor Protocol
Not Supported

MRS232C Protocol
Not Supported
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Supported Parameters:
Temperature 1

Temperature 2

Setpoint 1

Setpoint 2

Flow 1

Flow 2 (future expansion to Flow 10)

Analog input 1

Analog input 2

Resistivity 1

Resistivity 2

Supported Alarm Points:
Temperature 1 (high  low)

Temperature 2 (high  low)

Flow 1 (high  low)

Flow 2 (high  low)

Analog input 1 (high  low)

Analog input 2 (high  low)

Resistivity 1 (high  low)

Resistivity 2 (high  low)

NC Protocol Parameters
The NC protocol is designed to acquire all possible parameter
values from NESLAB proprietary controllers. Most (if not all) prod-
ucts supporting the NC protocol use only a subset of the entire
function set. When linking an indicator or chart parameter to a
protocol parameter for a given product, only those parameters
supported by the product are possible parameter choices.
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Options Menu

Select Options from the menu bar to configure and reset the COM
port.

Enable Communications

Select this menu item to re-enable serial communications follow-
ing a communications time-out error. This can also be done from
the properties panel and the communications panel. A controller
icon with a red background signifies that there has been a
communications error. Once the COM port has been re-initialized,
the product is polled by NEScom in order to establish contact. A
controller icon with a yellow background signifies that it is polling
the product. The icon will remain yellow until contact is made.
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Configure COM Port

Select this menu item to configure the communications port. The
control for enabling communications is available only when there
has been a communications time-out error. Under normal operat-
ing conditions this control is dimmed and gives the current com-
munication status. Enabling communications re-initializes the COM
port.

Communication is normally disabled when NEScom is not request-
ing parameters from the product. Once you configure NEScom to
request data from the product communication is automatically
enabled.

Select the Default button to set suggested RS232 settings
for the protocol in use.

MRS232/RS232: 300 Baud, 8 data bits, 1 stop bit, no parity,
polling interval 1.0 second.
MICROprocessor Bath: 4800 Baud, 8 data bits, 1 stop bit,
no parity, polling interval 1.0 second.
NC Protocol: 9600 Baud, 8 data bits, 1 stop bit, no parity,
polling interval 1.0 second.

Start-up configuration: Port: COM2, 9600 Baud, 8 data
bits, 1 stop bit, no parity, polling Interval 1.0 second.
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Window Menu

Select Window from the menu bar for arranging icons and restor-
ing window panels.

Arrange Icons

Select this menu to arrange controller icons in the NEScom main
window panel.

Moving an Icon
Icons can be moved within the main window. Clicking on the icon
changes the cursor to a pointing finger cursor. Moving the cursor
to the top edge of the icon changes the cursor back to the
default style. When the cursor changes back to the default style,
click and drag the icon to move it.

Window Panels

Lists all window panels opened. Click on the window panel
description to bring the panel to the front or restore a panel when
minimized. If there are no window panels opened then this section
of the menu is empty.
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Help Menu

Select this menu item for help in operating NEScom. Help is based
on the menu selections of the program. Help buttons on various
panels provide a shortcut to a help topic. Get to detailed informa-
tion on a topic by clicking on help links.

Contents

The contents of Help is based on the menu bar of NEScom.
Selecting this menu item brings up the HELP utility. Use the Tab key
to scroll through the HELP contents or double-click on a topic to
view that specific help screen.

Search

Search on a Help topic. Start by typing the first few letters of the
word to search. Click on a topic within the list of topics appearing
in the text box. Once a topic is selected, click on Display to get
help on the topic.

Warranty

Select this menu item to read the NESLAB warranty statement for
NESLAB products.
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On Line Manual

NESLAB provides on-line manuals which can be downloaded to
your computer.

Online documentation may be obtained 24 hours a day, 7 days a
week from NESLAB ONLINE, our public, online service support
system. NESLAB ONLINE is a FirstClass(r) system and we recom-
mend using FirstClass(r) Client software (see below).

Access to NESLAB ONLINE  is available in 13 simultaneous native
languages: Brazilian (dialect of Portuguese), Danish, English,
Finnish, French (Canadian), French (Parisian), German, Italian,
Japanese, Norwegian, Portuguese, Spanish and  Swedish.

Access is by direct dial-up only at (603) 427-2490.

We recommend using FirstClass(r) Client software (see below) to
access NESLAB ONLINE. Generic VT-100 terminal emulation may
be used by specifying 8-N-1 protocol, but be aware that the
graphical user interface, color, fonts, sound, teleconferencing,
some e-mail features, and native language access will not be
available.

When connecting, you will be asked to establish a User ID and
password. Whatever you choose will become your User ID and
password.

Online operation manuals may be found at: Conferences /
Operating Manuals

Online service manuals may be found at: Conferences /Service

FirstClass(r) Client software is free and available for Macintosh or
Windows (3.x or �95). The software is available from many sources:

AMERICA ONLINE: go to keyword �SOFTARC� then select �FirstClass
software�

COMPUSERVE: Mac client  is at TWEUROPA /Teletools /fcmac.zip
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Windows client is at PCBBS/BBS programs /FCC300.exe

WEB: download from http://www.softarc.com/try.htm

CD-ROM: Mac client is on the companion CD-ROM to the book
�Macintosh Revelations� by Ken Maki.

Mac client is on the companion CD-ROM to the magazine �Mac
Addict�, Sept. 1996 issue.

Mac client is on most CD-ROMs produced by BMUG.

We are not aware of the Windows client on any CD-ROM.

NESLAB ONLINE: Mac client is at: Conferences / Software / Mac /
FirstClass Client

Windows client is at: Conferences / Software / Windows / FirstClass
English

By mail: let us know and we will mail you a disk. Specify Mac or
Windows.

Note to MAC users: The application FirstClass Client may be run
directly off the floppy. It need not be copied to your hard drive

Service

NEScom provides a means for logging information on a product.
This simple interface keeps a record of any service information for a
product, like RMA numbers, and logs the date automatically. The
name field must be filled in for the entry to be added to the log.

A log entry is created by typing your name, the description of the
problem, then clicking on Add to write the entry to the log. Select
Close to abort entering data.
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Demo

A mock controller can be used in place of an actual product to
demonstrate NEScom features. Select Demo from the Help menu
and a controller box will appear. When a demo-controller is
created, the Demo menu item has a check mark. Selecting this
menu item with a check mark removes the demo-controller.

Rather than issuing commands over the communications interface
to an actual product, commands are intercepted and values
from the demo controller driver are used. Bring up charts and
indicators, run programs and setup alarms  just as if an actual
product existed.

First create a product icon, or open a file to restore a previously
saved workspace, then bring up the demo-driver. A pop-up
message will prompt for the temperature units. Select Fahrenheit,
Celsius or Cancel from bringing up the demo.
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Turn the DEMO ON!
You interact with the  demo just like an actual product. Switch the
ON/OFF switch to the ON position. The temperature follows the
setpoint within a half of a degree of error. With the switch in the
OFF position you can manually vary the temperature.

The following parameters are available for demonstration:

ON/OFF: Starts and stops the controller. When the DEMO controller
is ON, temperature follows the setpoint with a small margin of error.
This allows you to create and view a program, or view a chart of
temperature and setpoint. With the DEMO controller OFF, you can
manually adjust the setpoint.

Temperature Display:  Displays the temperature value.

Temperature:  Enter a value for temperature or use the controls to
vary the parameter.

Setpoint:  Enter a value for setpoint or use the controls to vary the
parameter.

High Temperature Limit:  Enter a value for the high temperature
limit or use the controls to vary the parameter.

Low Temperature Limit:  Enter a value for the low temperature limit
or use the controls to vary the parameter.

About

This displays copyright and license information relative to NEScom.
Make reference to this information when contacting NESLAB
support.
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Glossary

MICROprocessor Protocol: A communications protocol imple-
mented on NESLAB�s microprocessor line of baths and chillers.
Supports Delta-Temp.

MRS232C Protocol: Term used to describe the protocol used with
NESLAB�s MRS232C/RS232C apparatus for RS232 communications
on NESLAB�s digital line of products. Supports Delta-Temp.

NEScom : Windows application which communicates with support-
ing NESLAB products.

NC Protocol: A generic communications protocol designed to
acquire parameter values from NESLAB products supporting the
protocol (5/97).

Read Only:  When in read only mode, NEScom can only query a
product for information and not perform any intrusive setting of
product parameters (like temperature setpoint). Read Only mode
is disabled by entering the correct password in the Properties
Panel and selecting No on the Read Only switch.

With Read Only mode selected:

Programs cannot be started.
Setpoint cannot be changed from Product Panels.
Product Panel buttons are disabled.

Workspace: A workspace is made up of one or more controller
icons. If one is already active, NEScom will prompt you to save the
current workspace before a new one is defined or loaded. All
icons are cleared when a new workspace is created. Once new
controller icons are added, the workspace can be saved.
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Software Warranty

The media on which you receive NEScom are warranted not to fail
to execute programming instructions, due to defects in materials
and workmanship for a period of 90 days from the date of ship-
ment. NESLAB Instruments will, at its option, repair or replace
software media that do not execute programming instructions if
NESLAB Instruments receives notice of such defects during the
warranty period. NESLAB Instruments does not warrant that the
operation of the software shall be uninterrupted or error free.

NESLAB Instruments believes that the information in this manual is
accurate. The documentation has been carefully reviewed for
technical accuracy. In the event that technical or typographical
errors exist, NESLAB Instruments reserves the right to make changes
to subsequent editions of this document without prior notice to
holders of this addition. The reader should consult NESLAB Instru-
ments if errors are suspected. In no event shall NESLAB Instruments
be liable for any damages arising out of or related to this docu-
ment or the information contained in it.

NESLAB ASSUMES NO RESPONSIBILITY FOR INCIDENTAL, CONSEQUEN-
TIAL, OR OTHER DAMAGES INCLUDING, BUT NOT LIMITED TO LOSS OR
DAMAGE TO PROPERTY, LOSS OF PROFITS OR REVENUE, LOSS OF THE
UNIT, LOSS OF TIME, OR INCONVENIENCE.

The warranty provided herein does not cover damages, defects,
malfunctions or service failures caused by the owner's failure to
follow NESLAB  Instruments installation or operation instructions.
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NEScom Software Registration

To validate the warranty and to keep you updated, please
complete the information and return it to:

NESLAB Instruments
Software Registration
Attention: Marketing Department
P.O. Box 1178
Portsmouth, NH 03802-1178 USA

You may mail this information or fax it to 603 436-8411. Thank
you.

Name (First/Last) ___________________________________

Company Name ____________________________________

Company Division or Mailstop _________________________

Street Address _____________________________________

City/Zip ___________________________________________

State or Province ___________________________________

Country ___________________________________________

Software Name & Version ____________________________

Date Software Received (Month/Date/Year) ______________

What is your application for using this software product.
_________________________________________________
_________________________________________________

Please comment or give any suggestions you may have regard-
ing this software.
_______________________________________________
_______________________________________________





NEScom

NEScom Software License Agreement

Carefully read this license agreement before opening this soft-
ware or using NEScom Software.

Opening the sealed packet containing the software or using the
software indicates acceptance of this license agreement. If the
terms are not acceptable, contact NESLAB Customer Support at
1-800-4-NESLAB.

Ownership
NEScom Software programs and all accompanying materials are
owned by NESLAB Instruments. They are protected by United States
copyright laws, by laws of other nations, and by international
treaties.

License
NESLAB Instruments licenses each copy of the NEScom Software for
a single computer. Load NEScom into permanent memory of only
one computer and only use that copy on that same computer. Do
not install NEScom Software on a network.

Use and Transfer Restrictions
Do not copy NEScom Software except when making one copy for
backup or archival purposes. Transferring the NEScom Software to
a single hard disk is allowed provided the original is kept solely for
backup, or archival purposes. Do not copy any of the written
materials. Do not transfer, or assign the NEScom diskettes to any
another user.

Do not reverse engineer, decompile or disassemble the Software.
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